
 

 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 1/43 
 

GERBER ACCUMARK PE 
What’s New Fall 2023 / V16.1 

 

 

  

Date: Fall 2023 



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 2/43 
 

COPYRIGHT 

Gerber AccuMark 2D © 2023 Lectra SA and its affiliates. All rights reserved.   

This document may not be reproduced by any means, in whole or in part, without the written permission of the 

copyright owner.  

This document is part of the proprietary articles furnished to document Lectra SA and its affiliates support for 

Gerber AccuMark. 

In consideration for the furnishing of the information contained in this document, the party to whom it is given 

assumes its control and custody and agrees to the following: 

The information contained herein is given in confidence and any part thereof shall not be copied or reproduced 

without the written consent of Lectra. 

This document or the contents herein under no circumstances shall be used in the manufacture or reproduction 

of the articles shown, and the delivery of this document shall not constitute any right or license to do so. 

 

TRADEMARKS 

Gerber AccuMark, is a registered trademark of Lectra in the United States, all rights reserved. Other company 

names, brand names and product names mentioned in this document are trademarks or registered trademarks 

of their respective companies.  

DISCLAIMER 

The information contained in this document is subject to change without notice. Lectra SA and its affiliates  

shall not be liable for errors in this document or for incidental or consequential damages in connection with 

furnishing or use of this material, including, for example, loss of profits, fabric, and production time.   



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 3/43 
 

Contents  

Highlights ............................................................................................................................................. 5 

1. V16.1 General Improvements ......................................................................................................... 6 

1.1 Model Editor Enhancements .................................................................................................... 6 

1.2 CAD Relational Database - Number of Corners ........................................................................ 7 

1.3 Barcode Scaling ..................................................................................................................... 7 

1.4 Bidirectional Cutting Enhancement  .......................................................................................... 8 

2. V16.1 Pattern Design Improvements .............................................................................................. 9 

2.1 New Annotation Library  ........................................................................................................... 9 

2.2 Create Smaller Annotation Character Size...............................................................................11 

2.3 Hide Images  ..........................................................................................................................11 

2.4 Fabric Code with Image Labels ...............................................................................................12 

2.5 View Line Direction ................................................................................................................13 

2.6 Clip line Supports Multidimensional Grade...............................................................................13 

3. V16.1 Easy Marking Improvements ...............................................................................................14 

3.1 Piece Icon Selection ..............................................................................................................14 

3.2 Marker View ..........................................................................................................................14 

3.3 New Theme for Easy Marking.................................................................................................15 

4. V16.1 Lectra Digital Platform Integrations.....................................................................................17 

4.1 Link to Lectra Digital Platform .................................................................................................17 

4.2 New Kubix Link Integration – AccuMark Insight ........................................................................20 

4.3 Furniture and Fashion On Demand Integration Improvements ..................................................21 

4.4 Cloud Nesting Improvements..................................................................................................23 

5. V16.0 General Improvements ........................................................................................................25 

5.1 Alterations with Multi-Dimensional Grading ..............................................................................25 

5.2 User Interface Updates  ..........................................................................................................28 

5.3 Conversions  ..........................................................................................................................32 

5.4 Plotting Improvements for Annotation On Line .........................................................................32 

5.5 Updates to PERU ..................................................................................................................34 

5.6 Gerber AccuMark Localization ................................................................................................34 

5.7 Help/Documentation ..............................................................................................................35 

6. V16.0 Pattern Design Improvements .............................................................................................36 

6.1 View Alterations with Multidimensional Grade ..........................................................................36 

6.2 Create Altered Size with Multidimensional Grade .....................................................................36 

6.3 Plot Altered Size with Multidimensional Grade .........................................................................37 

6.4 New Function to Clip Image....................................................................................................38 



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 4/43 
 

6.5 Maintain Fullness Objects When Modifying..............................................................................39 

7. V16.0 Easy Marking Improvements ...............................................................................................40 

7.1 Relative Icon Size Preference.................................................................................................40 

7.2 PDF Supports Internal Line Label H for Digital Print Files  .........................................................41 

7.3 Additional Options for Quick and Flex Nesting for AccuMark markers  ........................................42 

 

  



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 5/43 
 

GERBER ACCUMARK®  

WHAT’S NEW FOR FALL 2023 

 

 

HIGHLIGHTS 

For AccuMark V16.1 users will find the following improvements and new features added to streamline the 

production workflow and to provide even more integration points.  

 

 Communicate consistently using the New Annotation Library   

 Simplify pattern modification with ability to Hide Images  

 View cutting direction using new Display Direction for internal and perimeter lines 

 Transition from Classic to Easy Marking with new theme  

 Integrations to Lectra 4.0 Offers such as Kubix Link and Fashion/Furniture On Demand  

 Create splices automatically when saving nests from the optional Cloud Nesting offer 
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1. V16.1 GENERAL IMPROVEMENTS 

1.1 Model Editor Enhancements 

AccuMark users will find new capability to quickly create or edit Model Options, by copying entries  

from the main Model’s Pieces tab to a Model Option.  Copying and pasting rows can be 

accomplished, even if the column order and visibility differ between the tabs. The corresponding 

information can be copied and will be pasted into the appropriate column. Users may choose to 

copy and paste entire rows or individual cells.  

New in V16.1, users in a network environment now have the ability to share Fabric Tables and 

Avatars. A model’s Fabric table and Avatar are no longer restricted to a local location, and now 

may be stored on a network drive. The default paths for these files are set in the AccuMark Explorer 

File Options on the User Settings tab.   

The responsiveness of the Model Editor piece look up has also been improved in this version. With 

the addition in prior versions of information such as stage, the browse dialog did not display as 

quickly as prior to the additional data fields. In this update, while the information is being loaded in 

the background users will not be able to sort on this data, but the look up can be used to choose 

pieces and browse for data.  

For storage areas with large amounts of data, while the list is being built in the background users  

may still select pieces and review the items in the storage area, but the columns may not be 

immediately available to resort the items.  

Columns that have information remaining to be loaded will display with a gray header. Users may 

still navigate to select data items while the information is being loaded. A message will display to 

indicate additional information is being loaded.  
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1.2 CAD Relational Database - Number of Corners 

Users who have configured a CAD Relational Database will find that a new column has been added 

to the Cad_Piece_Details table.  

This new column, Piece_Number_Corners, displays the information for the number of corners on 

pieces and will now be found when running a SQL query. Previously this information was only  

available in the AccuMark Piece Report. 

When saving data to a SQL Storage Area with the Relational Database configured, the new column 

will be added automatically to the existing database. 

 

1.3 Barcode Scaling  

While generating cut data, users may also choose to create a cut file or cut ticket barcode.  

Sometimes rendering the file name as a barcode produces a code that may be difficult to scan due 

to the size of the image, a situation that may occur with long file names.  The ability to scale the 

barcode has been added so that scanners will be able to more easily register the code.  
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The default value for scale is 100%, so users who currently do not have issues with the size of the 

barcode may continue without changing this field. Here is an example of a scaled barcode, 50%  

 

To compare, here is the same barcode at 100%.  

Additionally, sometimes when creating the barcode or QR code, some cutters require the full 

path, while others need only the file name as the cutter mapped drive is pointing to the cut file 

location. A new option has been added with the default of full path, but users may choose to have 

only the Cut File name.   

1.4 Bidirectional Cutting Enhancement  

Bidirectional cutting with a defined PDS Cut Sequence is now supported for folded or tubular 

fabrics. Cut sequence in PDS uses C and T point attributes to define the beginning and end of 

segments to cut, and the order in which those line segments are identified determine the line order 

for cutting.  

Previously when a mirrored piece was folded and placed along the folded or tubular edge of the 

marker, the PDS defined cut sequence was not applied. Now, when using these attributes on 

pieces that are mirrored and folded, the line cut order will be followed. Use of this feature requires  

that the Cutter Parameter Table be set to the enable the Bi-L/R Asymmetrical option.  

 

 

 

1. Pattern Design piece with defined cut sequence 

2. Resulting cut file on a tubular marker 
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2. V16.1 PATTERN DESIGN IMPROVEMENTS 

2.1 New Annotation Library  

Save time by quickly adding common text to patterns and share the library within your 

organization to increase consistency and avoid communication errors.  

Create and store common pattern text for development and production within the new AccuMark 

Annotation Library, and use this Library to add text with Annotation or Annotation on Line.  

The Annotation Library is a text file, which can easily be edited to add the most commonly used 

phrases or details important within your production environment.  

The default location for the AnnotationLibrary.txt is c:\userroot\system\state directory. The file may 

be stored to share in any network file location, allowing for consistency within the organization for 

annotation added to pieces.  

To view or change the path of this Annotation Library file, select Annotation Library from the PDS 

Edit Tab, Library panel. In this example, the path is the default location, but using the browse button 

will allow users to store this file in a common network location.  

 

 
 

Clicking Edit will open the file in a text editor associated with text files, such as Notepad. Once any 

edits have been made and saved, the text from the Annotation Library is visible and can be used 

when creating or editing Annotation or Annotation on Line. Edits to the Annotation Library may also 

be made directly in the PDS Annotation dialog.  

Entries added to the library appear in the dialog for Annotation and Annotation on Line. Add by 

selecting these entries from the right pane display and using the arrow key to send them to the Left  

pane for Add Annotation.  

Annotation Library entries may be added/removed from pieces using the using the left and right  

arrow keys.  The sequence for the annotation entries can be changed using the up and down 

arrows. The red X will remove the entry.  
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In this example, entries for Company, Customer and Due Date are added to the Annotation Library  

file and can be selected to add to pieces.  

 

 

To add annotation to the library, simply use the arrow key to add text from the Add Annotation pane 

to the Annotation Library pane in this dialog box.  In this example, new text will be added, “New 

Annotation to Add” by clicking the arrow to add the text to the Annotation Library.  

 

Entering the character size for plotting, rotation of the text, and applying grade rules to the 

annotation can all be performed with fields in this dialog. The entries within the Annotation Library  

can be used alone or with additional user defined annotation on individual pieces. 
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2.2 Create Smaller Annotation Character Size  

The custom character size range has been lowered to include 

a size range from .0125-3 inches (0.032-7.62cm). The smaller 

character size is helpful to ensure the annotation will fit within 

small pieces.   

 

2.3 Hide Images 

The new ability to Hide images allows simplified editing capability or design adjustments. The user 

interface design allows easy adoption to AccuMark image workflows with standard functionalities  

found in graphic programs. 

The ability to Hide Images allows users to access particular elements of layered images for editing 

purposes. Also, users can easily create variations for digital printing. This functionality maintains  

3D design elements using hide functionality for digital printing needs. 

The Hide/Show option is available for all images types within the Image Panel. Hidden Images 

retain the saved status from development to production, allowing users to create and apply multiple 

digital print variations. 

  

Locate the new icon in the Image panel. The feature is available and color coded for all image 

types: fabrics, trims, edges, and labels. Within the Image panel, the images are organized by piece.  

Saving the model will save the image display state and carry through production to marking,  

plotting, or printing. Hide Image allows more flexibility and options within a single model when 

working with images. 
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2.4 Fabric Code with Image Labels 

A new Fabric Code identifier is added to the piece image label selection. This improvement helps 

visualize the materials needed to produce a product from design to production with digital 

printing. 

To Add a Fabric Code to the Image Label: 

1. Open Pattern Design and select Place Image (Image Type=Label) from the Image tab.  

2. Use the lookup in the Label Info to open the Label Info Format dialog.  

3. Left click on Fabric Code and press Add. The position of the fabric code within the label 

is defined by selecting the cell or using the New Line button.  

4. Select OK once all information is selected. 

5. You will now see the fabric code displayed within the image label on the piece.  
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2.5 View Line Direction 

Direction, a new option in the View Panel, toggles the display of the internal line direction to validate 

cut direction, so that users can see this information and edit internal lines as needed.  

When using pieces that were created by another user or re used from prior seasons, it may not be 

immediately apparent in which direction a particular line segment was created. This new view 

capability is very useful to provide information while making pattern modifications.   

Select the Direction icon in the View tab to enable directional arrow display . Choosing the icon 

again will toggle the direction view off. This new capability will allow users to  

 Understand internal cut direction to generate efficient cut files  

 Improve visual feedback for the cut start location on piece perimeters  

Users can display the line direction whether or not the internals are assigned to cut.  

 

 

 

 

 

 

2.6 Clip line Supports Multidimensional Grade 

Located in the Modify tab of Pattern Design, Clip Line quickly adjusts internal lines to intersect at 

a defined location. The option, Clip by Piece, allows the internal to clip at the perimeter locations.  

In V16.1, Clip Line supports pieces with multidimensional grades. To use this update, ensure the 

internal line grade before using the clip function. Then select Clip Line and the option Clip by Piece. 

After selecting the piece, notice in steps 2 & 3 how the grade follows the defined grade dimension.

 

1. Piece prior to Clip Line with graded internal 

2. View of D1 after Clip Line is applied with option Clip by Piece 

3. View of D2 after Clip Line is applied with option Clip by Piece 
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3. V16.1 EASY MARKING IMPROVEMENTS 

3.1 Piece Icon Selection  

When selecting piece icons for placement into the marker workspace, the gap between the 

displayed items has been decreased to increase the work area. The images below depict the same 

marker quantities in version 16.1 compared to prior, with the reduction in space in both the rows 

as well as column displays.   

The icon margin sensitivity has been improved to allow users to more easily choose pieces to slide 

into place. If the marker is zoomed to overlap into the icon menu area, users will still be able to 

choose those pieces for placement. 

 

 

 

 

3.2 Marker View  

When selecting Full Length or Big Scale to change the view of markers in Easy Marking, the marker 

display will remain in the work area. This positioning maintains a space from the piece icon menu,  

allowing users to access the icons for selection without the pieces being overlapped into the marker 

display. In this example, the Big Scale display does not extend into the icon selection area.  
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3.3 New Theme for Easy Marking 

A new User customizable theme to has been added to transition users from classic to Easy 

Marking. With this new theme, users will find increased marker workspace and a Classic color 

palette for various screen elements.  

From the View Tab, choose Screen Options and Colors located in the Display Panel. When the 

dialog opens, choosing the “Classic” button will set the colors for background, matrix text, piece 

fill, borders, offsets, and piece line colors to the Classic Marking settings.  

 

 

 

The ribbon menu will be collapsed and the thumbnail hidden to provide more screen area for the 

marker display. Users can select the Classic theme and then also make modifications – such as 

changing the icon display or any of the color options before clicking OK to save the changes.   

Using options found in the View tab, other screen elements can additionally be hidden to gain more 

space for marking including the Marker Info bar.  

Other general improvements have been made for Easy Marking to assist users in the transition 

away from Classic including a slight change in the cursor focus for Full Scale and the font display 

on pieces in the work area.  
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3.3.1 Classic Marking Sunset 

Classic Marking has been removed in this version. Users will no longer have the option 

in AccuMark Explorer and other AccuMark applications to open marker data in Classic 

Marking.  

This transition to Easy Marking ensures compatibility with ongoing Microsoft Operating 

System updated including Windows 11. Also, this change allows increased graphic  

stability and support for newer graphics drivers and interface.  

Since the introduction of Easy Marking, development and enhancements to marking have 

only been done for this interface. All the latest features and improvements have only been 

included in Easy Marking, including support for images and Sending markers to nest in 

the cloud.  
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4. V16.1 LECTRA DIGITAL PLATFORM INTEGRATIONS 

4.1 Link to Lectra Digital Platform  

For customers connected to Lectra 4.0 solutions such as Kubix Link or Fashion/Furniture On 

Demand, AccuMark models are available for direct use within the Lectra Digital Platform. This  

integration provides accurate pattern files from AccuMark Explorer.  

4.1.1 Linking a Storage Area 

A storage area must first be linked to the Lectra Digital Platform for models to upload and sync. 

There is no limit on the number of storage areas that can be linked.  

To Link a Storage Area: 

1. Select the storage area(s) to link from AccuMark Explorer. The 

storage area can be a local, network, SQL, or SQL subfolder.  

Note the option to link is only available with the following 

requirements: 

a. User Licensing is the license method 

b. User/company account is associated with either 

Kubix Link or Fashion/Furniture On Demand  

2. With the storage area(s) selected, right-click and choose the 

option Link to Lectra Digital Platform. 

3. Once linked, the storage area will display a share symbol, and 

as you save models, the files will be uploaded and 

synchronized with the latest updates in the Lectra Digital 

Platform.  

Note that linking a storage area only establishes a connection. A model save or storage area sync 

is required to upload model(s) to the Lectra Digital Platform. 

4.1.2 Unlinking a Storage Area 

To stop data synchronization to the Lectra Digital Platform, users can right -click on any linked 

storage area and select Unlink to Lectra Digital Platform. This action will remove the share symbol 

from the storage area folder and delete all models shared in the Lectra Digital Platform. Use this 

feature with caution as it will impact the Lectra 4.0 solutions referencing these pattern files .  

4.1.3 Sync Storage Area 

When initially configuring AccuMark data to Kubix Link, it is possible to upload all models within a  

storage area. The sync provides a background utility to automate the upload process for multiple 

models. Note depending on the storage area size, this can take some time to complete. At any 

point, you can reference the Activity Log located in the View tab of AccuMark Explorer to review 

the upload status. 
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To Sync Storage Area(s) to the Lectra Digital Platform: 

1. Open AccuMark Explorer, and from the File menu, select Options.  

2. Within the AccuMark Utilities dialog, select the Storage Areas tab and locate the Sync 

Storage Area section. 

3. Select Lectra Digital Platform and click Browse. Choose all storage areas to sync. Note 

that only linked storage areas will be available to sync. 

4. When all storage area(s) are selected, click Sync Database. 
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4.1.4 Best Practices 

Actions taken within the AccuMark environment can impact AccuMark data stored within the Lectra 

Digital platform.   

 Deleting Linked Models/Storage Areas 

If you delete a model in AccuMark from a linked storage area, then the model will be 

deleted from the Lectra Digital Platform. If you delete a linked storage area in AccuMark 

Explorer, all models uploaded to the Lectra Digital Platform will be deleted.  

 Renaming Linked Models/Storage Areas 

If you rename a model in AccuMark from a linked storage area, then the model will be 

updated in the Lectra Digital Platform. If you rename a linked storage area in AccuMark 

Explorer, the path for all models uploaded to the Lectra Digital Platform will be updated. 

 Missing Components 

 To ensure data accuracy for the Lectra 4.0 production solutions, if AccuMark models are 

missing components such as pieces or matching rules, those models will not be uploaded 

and synced to the Lectra Digital Platform. Review the model upload status at any time 

within the AccuMark Activity Log. 

 Activity Log  

Located in the View tab of AccuMark Explorer, the Activity Log will list the status of models  

shared with the Lectra Digital Platform.  
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4.2 New Kubix Link Integration – AccuMark Insight  

Kubix Link, our fashion PLM, enables product-centric organizations to work from one official data 

source, which is always updated and easily accessible to every fashion industry stakeholder in 

their supply chain. 

AccuMark Insight is a Kubix Link extension that lets you view real-time information from AccuMark 

pattern files and its latest updates. 

AccuMark Insight allows you to view pattern sizes and pieces easily without access to AccuMark. 

Accelerate product development by easily sharing information with your subcontractors and team.  

In addition, you can update patterns quickly by opening patterns from Kubix Link directly in Pattern 

Design or downloading then in native .zip file format for subcontractors. Track the progress of your 

models and save time in the development phases. 

How It Works 

1. Link the necessary AccuMark storage areas where the shared model data resides and 

save models or sync the storage area(s).  

2. In Kubix Link, create a pattern section within an article and link your AccuMark model file 

and its measure chart. 

3. Pattern data is automatically updated: pattern, size line, and measure chart information is 

displayed. 

4. Access models any time from Kubix Link when AccuMark is installed on your computer.  
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4.3 Furniture and Fashion On Demand Integration Improvements  

Furniture and Fashion On Demand by Lectra connects and automates on-demand production – 

from order reception to cut pieces. It’s a turnkey solution comprising Lectra’s Digital Cutting 

Platform. 

In the Fall AccuMark release, there are integration improvements to expand on data 

interoperability. These updates include: 

 Direct data access to the Lectra Digital Platform 

Users can remain in AccuMark and upload models to the Lectra Digital Platform without  

leaving AccuMark Explorer. No longer are separate conversions required! For more 

information on connecting to the Lectra Digital Platform, review section 4.1 of this guide.  

 Support for customized product with material matching  

AccuMark customized models with model options are now converted automatically to an 

MDL variant with supporting motif points and matching links.  

 

4.3.1 Model CAD Variant – Matching Rules  

There is a new entry in the AccuMark model editor to link matching rules when 

applicable.* When a model contains matching points, the corresponding matching rule 

can be linked within the model tab. This link ensures that the model + matching rules are 

uploaded and converted together for accurate usage in the Furniture and Fashion On 

Demand platform. Note all components, including pieces and matching rules, must exist 

in the linked storage area for the model to upload to the Lectra Digital Platform. 

If a matching rule is updated, all the models linked with the matching rule will resync to 

the Lectra Digital Platform to ensure the utilization of the latest matching information.  

 

*In order to view the new CAD Variant section in the model, the user must have a user 

license account associated with Furniture or Fashion On Demand.  
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4.3.2 Utilizing Find 

AccuMark Find helps manage models where matching rules are linked. A new option 

added in the Advanced tab allows users to find models that contain a specified matching 

rule. Users can right-click on the search results to manage as needed.  
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4.4 Cloud Nesting Improvements 

Additional functionality has been added to the optional cloud nesting offerings  – Flex or Quick. For 

more information on how to add this capability to your AccuMark software, please contact your 

sales representative.  

4.4.1 Do Not Nest Pieces in the Menu 

Sending AccuMark marker data directly to Flex or Quick Nest now has the ability to send only the 

pieces in the marker work area, ignoring the pieces within the piece icon menu. The selection “Do 

not nest pieces in the Menu” becomes active with Restart /Unplace All Pieces. This checkbox allows 

sending markers to nest when more pieces were ordered than need to be placed in the completed 

nest.  

 

4.4.2 Generate Splices  

When submitting jobs to nest, new settings in the dialog have been added to allow Splices to be 

automatically created, using the defined Minimum/Maximum and Margin amounts. The splices will  

be added to the marker as the nested marker is saved back into the AccuMark Storage Area.  

The values display in the currently select Notation: cm for Metric, or in for Imperial. The unit setting 

field is found in the Configure Menu of the dialog. Select the Generate Splices checkbox to enable 

the fields for editing.  

 Minimum – This setting determines the shortest length of a splice mark allowed 

 Maximum – Entering this setting determines the longest length of a splice mark allowed 

 Margin – Controls how much will be added to either side of a splice mark to ensure all  

pieces are cut 

 Separation – Distance from the marker border to splice  

 Display – Determines where the visual representation of the splices will appear, top,  

bottom, inside, outside of the marker 
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4.4.3 View Details in the Cloud  

Detailed information for nested markers now displays in the cloud for the Flex or Quick view.  

Select the icon to view information including the AccuMark Model Name, Model Options, Fabric  

Types available for the Model, and quantities ordered for the marker. 
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5. V16.0 GENERAL IMPROVEMENTS 

5.1 Alterations with Multi-Dimensional Grading 

Increase customer size offerings by combining the functionality of alterations with multi-

dimensional grade. Combining the rule-based movements with the grading approach simplifies  

complex adjustments to generate an accurate product fit. 

 

Alterations and multi-dimensional grading are features in AccuMark that allow for fit customization.  

Alterations utilize point ids and rules to define a custom movement. Multi -dimensional grade 

assigns multiple size lines (rule tables) to a piece allowing movement by grade rules in each 

dimension. Before this release, only one customization method was allowed. If multi-dimensional 

graded was stored in a piece, all alteration functionality would automatically be blocked.  

 

This is a fully integrated solution throughout the Gerber AccuMark software suite. General 

Guidelines include: 

 You can’t use a size separator character in any dimension of the piece size name.  

 For selection, always reference D1.  

 

5.1.1 Size Code and Multidimensional Grade 

There is no change to the size code editor to support the grading enhancement allowing an easy 

transition for continued use of existing editors. Note that all ordered sizes continue to list only  

Dimension 1 (D1) size names. In the Order Editor and Pattern Design size selection fields, all  

multidimensional sizes will be available for the defined actual sizes.  

Examples of Order Size Names  

Order Number Customer Name Size Name 

   

NOTE: For more information on multi-dimensional grade, refer to the v12 What’s New 
documentation in C:\ProgramData\Gerber Technology\Training Docs\AccuMark 
Documentation\What’s New Previous 

Ordered Size  

Actual Size  
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5.1.2 Orders with Alterations and Multidimensional Grade  

The basic ordering process remains unchanged. However, select a model with multidimensional 

grade, and the alteration and size code fields remain active. The previous behavior blocked these 

selections. 

To order a marker with Alterations and Multidimensional Grade: 

1. From AccuMark Explorer, go to File→New→Order.  

2. Enter all the required parameters in the Order tab, such as the Lay Limit, Annotation, and 

Fabric Width.  

3. In the Model tab, select a model with multidimensional grade. 

4. Next, select the alteration and size code editors. 

5. For the size selection, use the lookup to select sizes. The ordered size names defined in 

the size code display with all available dimensions. Use the matrix selection to refine the 

selection. 

6. Enter all remaining quantities, fabrics, and optional items like model options.  

7. From the toolbar, Process the order. 

  

Ordered Size Names are availab le with Multiple 

Dimensions 

Orders processed successfully with Alterations 

and Multidimensional Grade  

 

5.1.3 Plotting Alterations and Multidimensional Grade 

Plotting pieces or models in AccuMark Explorer adds the option to plot Alterations with 

Multidimensional Grade. This functionality allows you to plot a sample and validate the fit. Once 

the alteration and size code are defined, the size selection will update with the multidimensional 

size name.  
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5.1.4 Reports with Alterations and Multidimensional Grade  

Reporting options such as Alter Piece Perimeter now allow models with multidimensional 

grade to be selected and reviewed with an alteration library and size code. This helps to 

understand the altered piece area for costing calculations.  
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5.2 User Interface Updates  

With the release of the April 2023 AccuMark, users will find even more improvements for editors  

used for the most common workflows. The new look of these forms is part of an ongoing project to 

refresh the look of the software, while improving user productivity. Additions of a ribbon menu,  

common functionality and simplified colors make navigation easy.  

The ribbon menu allows users to rapidly perform common data management tasks including 

opening new forms, making edits to the form, locating and navigating to an item or accessing the 

online help resources. Users can also take advantage of the common features in newly redesigned 

forms including creating a custom Quick Access Toolbar for even more flexibility.  

5.2.1 Updated Annotation Editor 

The updated AccuMark Annotation Editor now displays the category and annotation in an updated 

format, and the look up provides access to an interactive grid that allows selections to be made 

and added to define the annotation that will plot on pieces and/or markers. The new ribbon groups 

functionality into a File menu as well as Home, View and Help tabs.  

 

Users may still type directly in the category and annotation fields on the main page. New lines are 

automatically added to the grid as more entries are made.  
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A dialog box for Annotation Format opens when the lookup control is selected in within an 

Annotation Cell. Annotation Type can be selected from the left list box, then added to the Selection 

group on the right. Controls in the center of the dialog box allows choices to be moved from one 

list box to the other. Control and Shift keys can be used to select multiple items to move.  

 

 

 
 

1.1.1 Updated Size Code Editor  

The new look for the Size Code includes a File Menu, as well as Home, Size, View and Help tabs. 

Alteration Rule names and the alteration amounts display in a grid with headers displaying the 

Ordered Size. Tabs above the grid list each actual size. The active actual size being edited is 

highlighted in blue. 

Simplified icons will add, copy, delete and arrange the actual or ordered sizes in the display. Use 

the Home Tab tools to perform Windows clipboard features such as cut/copy/paste as well as to 

undo or redo actions while editing. The Search icon will perform a general windows search of the 

data in the grid while the Settings allow you to open the User Environment Parameter table for edit.  
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Use the Size Tab to add, delete and rearrange the Actual Ordered Sizes. Powerful Find tools allow 

search criteria to be defined to locate sizes with specific alteration names and / or alteration 

amounts.  

 

 

 

The view tab allows the status bar to be shown/hidden, which will display the total number of actual 

sizes in the open Size Code table. To use a dark theme, choose “Monarch Dark” from the View 

tab.  

 

The Help tab provides access to useful reference material including the Help File, current version 

documents for What’s New and Release Notes.  

Use Context menus, accessed by a right mouse click, within the cells of the grid to perform common 

editing tasks such as Cut, Copy, Paste as well as to delete or insert rows.  
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The width of the columns can be adjusted by simply dragging the divider. A right mouse click will  

offer the option to Reset the column width to the original default. The Alteration rule amount column 

indicates if the units of measure for the alteration is set for inches, centimeters or millimeters which 

is determined by the User Environment Parameter Table.  

 

 

In addition to the updated look for the Annotation and Size Code Editors, performance 

improvements have been made for AccuMark MTM. Review the MTM What’s New document for 

details on the changes changes made to improve speed and responsiveness.  
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5.3 Conversions 

An expanded selection of AccuMark labels, including label S, is added to convert Quality Zone 

Separators when exporting to Modaris format. This offers support for producing products often cut 

on leather where quality or shade zones indicate optimal placement for cutting. By adding 

additional labels, AccuMark users can quickly convert files to integrate with Lectra cutters and 4.0 

solutions without altering existing data.  

 

 

5.4 Plotting Improvements for Annotation On Line  

Annotation on Line was introduced in AccuMark 15.1, where text follows the path an internal or 

perimeter line to indicate production information in specific locations. The feature is updated in 16.0 

to support additional plot options for both piece and marker plotting. The list below highlights the 

supported plot scenarios.  

 

Piece Plot 

 Scale 

 Rotate  

 Mirrored 

 Save as image 

 Plot altered  



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 33/43 
 

Marker Plot 

 Marker scale 

 Folded pieces  

 Mirrored pieces 

 Flip pieces 

 Annotation on seam  

 

Conversion 

 Standard DXF  

 

 

  

NOTE: For more information on annotation on line, refer to the v15 What’s New documentation 

in C:\ProgramData\Gerber Technology\Training Docs\AccuMark Documentation\What’s New 
Previous 
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5.5 Updates to PERU 

Known issues and know requests submitted through the Gerber Problem and Enhancement Report  

Utility now notify Lectra Customer Success to open a support ticket.  

5.6 Gerber AccuMark Localization 

We are excited to announce our updated translation process for the AccuMark software suite. Our 

goal is to obtain consistency for the lexicon for the entire portfolio at Lectra and maintain a high 

level of translation quality to meet our premium positioning with dedicated terms of our 3 market  

strategic sectors: fashion, furniture, and automotive. 

Starting from v16.0, each release of the AccuMark software suite with its translations will be 

available at the same time as the English version.  

5.6.1 Supported Languages 

The Gerber AccuMark Suite officially translates into ten languages. 

 French 

 Italian 

 Spanish 

 German 

 Portuguese 

 Simplified Chinese 

 Traditional Chinese 

 Turkish 

 Polish 

 Japanese  

In additional to the above ten languages, we also provide a Hong Kong Language Pack with 

Traditional Chinese content.  

5.6.2 Documentation 

What’s New documentation will translate in the above languages following the same methodology 

as the software. New for v16.0, the translated doucmentation will be embedded into the language 

pack. From the Help Tab of the software program (example: AccuMark Explorer > Help Tab > 

What’s New Icon) the translated documentation is avabilable for the language pack installed. We 

are providing you translated contents in real time with the new Features.  

 

If a translation is not provided for a What’s New, the content remains in English. Images inside the 

What’s New documentation remains in English. The Release Note documentation remains in 

English.  
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5.7 Help/Documentation 

The Help tab icons now match to the help icons displayed in the Introductory Help to easily identify  

the support functionality in all AccuMark applications.  

 

 

 

Microsoft has ended support for the XPS file format and retired the XPS Viewer program. As 

Microsoft no longer issues security updates for this viewer application, the AccuMark 

documentation is no longer installed in this format. Documents detailing the new features and 

system requirements will be provided as PDF files.     
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6. V16.0 PATTERN DESIGN IMPROVEMENTS   

6.1 View Alterations with Multidimensional Grade 

All functionality with alterations supports models/pieces utilizing multidimensional grade. Use the 

feature View Alterations to visualize the piece geometry for custom-fit patterns. 

To View Alterations with Multidimensional Graded Pieces: 

1. Open the model in Pattern Design, place desired piece(s) in the work area, and go to 

Grade → Altered Sizes. Select piece(s) to view and ensure D1 is the active dimension.  

2. Select the alteration library and alteration rules to display. The size code option is 

available if the rules and values are predefined. Press OK to continue.  

3. The following Show Altered Sizes dialog provides the size(s) to view. By default, all 

multidimensional size combinations display. To manage large-size sets, use the Matrix 

Selection option with the ctrl or shift key for multi-selection. When finished, select OK.   

4. The altered piece will display in the work area as cumulative or nested lines showing the 

altered movement based on the geometry of the selected multidimensional graded size.  

Step 2 - Setup Step 3 - Size Selection Resulting Display 

 
 

 

6.2 Create Altered Size with Multidimensional Grade 

All functionality with alterations supports models/pieces utilizing multidimensional grade. Use the 

feature Create Altered Size to verify the piece measurements for custom-fit patterns or generate a 

new pattern piece. The same selection process applies to all alterations features in Pattern Design.  

To Create Altered Sizes with Multidimensional Graded Pieces: 

1. Place piece(s) in Pattern Design work area and go to Create → Altered Sizes. Select 

piece(s) to create and ensure D1 is the active dimension.  

2. Select the alteration library and alteration rules to generate. The size code option is 

available if the rules and values are predefined. Press OK to continue. 

3. The following Show Altered Sizes dialog provides the size(s) to create. By default, all 

multidimensional size combinations display. To manage large-size sets, use the Matrix 

Selection option with the ctrl or shift key for multi-selection. When finished, select OK. 
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4. The altered piece will generate as a separate piece(s) with the altered movement based 

on the geometry of the selected multidimensional graded size.  

Step 2 - Setup Step 3 - Size Selection Resulting Display 

 
  

6.3 Plot Altered Size with Multidimensional Grade  

All functionality with alterations supports models/pieces utilizing multidimensional grade. Use the 

feature Plot Altered to verify the piece measurements for custom-fit patterns or for sample 

production. The same selection process applies to all alterations features in Pattern Design. 

To Plot Altered Sizes with Multidimensional Graded Pieces:  

1. Place piece(s) in Pattern Design work area and go to File → Plot Altered. Select piece(s) 

to plot and ensure D1 is the active dimension.  

2. Select the alteration library and alteration rules to plot. The size code option is available 

if the rules and values are predefined. Press OK to continue.  

3. The following Show Altered Sizes dialog provides the size(s) to plot. By default, all 

multidimensional size combinations display. To manage large-size sets, use the Matrix 

Selection option with the ctrl or shift key for multi-selection. When finished, select OK. 

4. The altered piece will plot to the destination defined in the Preferences with the altered 

movement based on the geometry of the selected multidimensional graded size. 

Step 2 - Setup Step 3 - Size Selection Resulting Display 

 
  

NOTE: The new altered piece does not contain the graded nest. Use the option New Piece Name 
to avoid overwriting the original pattern. 



 

GERBER ACCUMARK PE 

 

Gerber AccuMark is a registered trademark of  Lectra. Other trademarks 

mentioned in this document are the property  of  their respectiv e owners.  

 

lectra.com 38/43 
 

6.4 New Function to Clip Image  

Clip image easily maintains complex graphic placement for all sizes by utilizing the powerful grade 

features for internal lines. No longer spend hours in graphic programs to align images for individual 

sizes. Instead, only simple blocks are needed, and the image will clip to the selected graded 

internals. 

To Clip Images: 

1. Add internal design lines to the piece using any create line function. Select Add Grade 

Rules on Intersection option to add grade to the internal line.   

2. Place trim image(s) on a piece. 

3. From the Images tab, select Clip in the Modify panel. 

4. Select the image to clip. 

5. Then use the Ctrl key in Click n Go mode to select all internal lines to clip the image. 

6. Select the image on the side/region to keep.  

7. Repeat as needed.    

Clip Image to Internal Lines Simple Artwork Preparation 

  

Automatically Clips to Graded Internal Lines 
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Use the same Clip function to unclip an image. To Unclip Images: 

1. From the Images tab, select Clip in the Modify panel. 

2. Select the image to unclip. 

3. Then use the Ctrl key in Click n Go mode to select all internal lines to unclip.  

4. Repeat as needed.    

 

6.5 Maintain Fullness Objects When Modifying 

Fullness now supports maintaining the object when performing Modify functions such as Combine 

Piece. This expanded feature support is helpful to edit, close, or delete the fullness as modifications 

occur.   

  

Before Combine Piece After Combine Piece→Fullness Object Maintained 
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7. V16.0 EASY MARKING IMPROVEMENTS 

7.1 Relative Icon Size Preference  

Manual marker makers can now view the relative size of pieces in relation to each other before dragging 

them into the marking area. The Settings Dialog box now includes a checkbox for “Relative Icon Size”  

which will apply to the icon menu and piece view displays. The default setting for this new option is Off.  

 

 

In the image below, the Relative Icon Size is off. Piece icon sizes display in the same scale no matter 

what the size of the actual piece geometry. For example, the back pieces appear as large as the collars  

and cuffs.  

 

 

When the setting is checked, the piece images in the menu are scaled to display relative size. The 

collars and cuffs are shown smaller than the back, fronts, and sleeves.  
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7.2 PDF Supports Internal Line Label H for Digital Print Files 

New support for internal cut lines with digital print files reduces ink consumption by only printing 

desired areas.  

To utilize this improvement, you can add a closed internal H line label to the piece(s) in Pattern 

Design. Once the production marker is ordered and processed, the internal cutout will accurately  

display in Easy Marking. Use the feature Save as 1:1 in Easy Marking to create the digital print file.   

 

Internal H Closed Cutout 

 

Cutout Supported in PDF Digital Print File 
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7.3 Additional Options for Quick and Flex Nesting for AccuMark markers 

7.3.1 Send to Cloud Nesting from Easy Marking  

Send markers now to Cloud Nesting directly from Easy Marking using a new selection to the File 

Menu.  This new capability allows users to partially place markers to control placement of particular 

pieces, then finish the marker with the power of Cloud Nesting.  

 

7.3.2 Sectional and Shade Zone Support 

Continuing the work begun in AccuMark version 15.1.0, users can now define sections and shade 

zones for markers being sent for Cloud Nesting. These offers require a subscription for nesting,  

which can be purchased by contacting your sales representative.   

 

 
 

Quick and Flex offer an automated cloud-based nesting capability for costing, procurement and 

production.   

 Quick gives brands and retailers the ability to fast-track product development for new items 

with agility and ease. 

 Flex is designed for manufacturers with a high volume of markers to provide a balance for 

different production cycles and ensures users can efficiently manage activity peaks.  
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Set the preferences for nesting for sections and shade zones in the dialog box that appears when 

sending markers to cloud nesting.  

 

 

Sections allow for pieces to be grouped together for cutting and picking purposes and are often 

used during step spreading.  

 

 

Shade zone are horizontal zones intended to allow pieces to be grouped together for fabrics with 

shade variations, lighter or darker in certain places.   

 

 

 


